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General Education Rubrics for Assessment 
 
Objective 1.3: Computing Literacy 
Students will effectively and responsibly use appropriate computer applications for communication, scholarship, and problem-solving.  
 
By graduation students 
will: 

Not Proficient 
1 Point 

Developing Proficiency 
2 Points 

Proficient 
3 Points 

Exceeding Proficiency 
4 Points 

Effectively perform data 
analysis using appropriate 
technology such as 
spreadsheets or database 
applications.  
 
 
Using Excel Pivot Tables 
assignment.   

 The student designed 
and formatted the 
pivot table with major 
errors. In some cases, 
the correct functions 
were not used, the 
correct filters were 
not used, and the 
amount fields were 
not properly placed.    

 The student designed and 
formatted the pivot table with 
minor errors. In some cases, 
the correct functions were not 
used, the correct filters were 
used, and the amount fields 
were not all properly placed.    

 The student designed 
and formatted the pivot 
table correctly. The 
correct functions were 
used, the correct filters 
were used, and the 
amount fields were 
properly placed.    

 The student designed and 
formatted the pivot table 
correctly. The correct 
functions were used, the 
correct filters were used, and 
the amount fields were 
properly placed. The 
formatting is very 
professional.    

Effectively format 
documents such as 
reports, essays, or resumes 
using appropriate 
technology. 
 
 
Formatting Research 
Paper assignment. 

 The student 
misapplied the MLA 
style requirements in 
many cases. The 
student did not 
include all the 
required content.  The 
student did not use 
proper software 
techniques.   

  The student applied nearly 
all the MLA style 
requirements correctly. The 
student included most of the 
required content. The student 
used proper software 
techniques for most of the 
assignment.  

 The student applied all  
the MLA style 
requirements correctly. 
The student included all 
of the required content.  
The student used proper 
software techniques.   

 The student applied all of the 
MLA style requirements 
correctly. The student 
included all the required 
content.  The student used 
proper software techniques. 
The document has an 
exceptional overall design.   

Design effective 
presentations using 
appropriate technology.  
 
 
 
 

The student included 
some of the required 
elements. The student 
lacked skill in using 
the proper software 
techniques in many 
cases. The quality of 

 The student included most of 
the required elements. The 
student demonstrated skill in 
using the proper software 
techniques in some but not all 
cases. The quality of the 
content was lacking in some 

 The student included 
all the required 
elements. The student 
demonstrated skill in 
using the proper 
software techniques. 
The quality of the 

  The student included all the 
required elements. The 
student demonstrated skill in 
using the proper software 
techniques. The quality of the 
content was evident. The 
presentation had a very good 



 
 
Advanced PowerPoint 
assignment  

the content was 
inconsistent. The 
presentation did not 
have an overall good 
design.    

cases. The presentation had 
some good design qualities. 

content was evident. 
The presentation had a 
very good overall 
design.   

overall design.  The overall 
work is exceptional.   

Successfully perform a 
task with others using 
collaborative technology. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Collaboration 
assignment.   

 The document was 
properly shared 
electronically with a 
colleague, but the 
feedback was 
minimal. The 
document was 
improperly edited.  
The student 
demonstrated some 
reflection about the 
uses of social media 
but the level of 
reflection was very 
limited.  The student 
demonstrated mastery 
of few of the editing 
functions in Microsoft 
Word.   

 The document was properly 
shared electronically with a 
colleague, feedback was 
received and incorporated, 
and the document was 
properly edited.  The student 
demonstrated some reflection 
about the uses of social 
media but the level of 
reflection was somewhat 
limited.  The student 
demonstrated mastery of 
some of the editing functions 
in Microsoft Word.   

 The document was 
properly shared 
electronically with a 
colleague, feedback was 
received and 
incorporated, and the 
document was properly 
edited.  The student 
demonstrated some 
reflection about the uses 
of social media.  The 
student demonstrated 
mastery of the editing 
functions in Microsoft 
Word.   

 The document was properly 
shared electronically with a 
colleague, feedback was 
received and incorporated, 
and the document was 
properly edited.  The student 
demonstrated some reflection 
about the uses of social 
media.  The student 
demonstrated mastery of the 
editing functions in Microsoft 
Word. The student produced 
an excellent document that 
shows an exceptional depth 
of reflection and attention to 
skilled editing. 

Identify the ethical and 
legal standards of conduct 
regarding the use of data 
and technology.   
 
 
 
 
 
 
 
 
 

 The student 
demonstrates a partial 
understanding of 
copyright and 
Creative Commons 
licensing in the short 
essay. The student 
attempts to explain 
differences between 
the surface web, the 
deep web, and the 
dark web but should 
have added much 

 The student demonstrates a 
partial understanding of 
copyright and Creative 
Commons licensing in the 
short essay. The student 
explains some differences 
between the surface web, the 
deep web, and the dark web 
but should have added some 
additional detail. The student 
articulates the ethical 
dimensions of libertarian 
views. The student attempts 

 The student 
demonstrates an 
understanding of 
copyright and Creative 
Commons licensing in 
the short essay. The 
student explains 
differences between the 
surface web, the deep 
web, and the dark web 
adequately. The student 
articulates the ethical 
dimensions of 

 The student demonstrates an 
understanding of copyright 
and Creative Commons 
licensing in the short essay. 
The student explains 
differences between the 
surface web, the deep web, 
and the dark web 
exceptionally well. The 
student articulates the ethical 
dimensions of libertarian 
views. The student explains 
the technical essentials of the 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Dark Web assignment.  

more detail. The 
student should 
articulate the ethical 
dimensions of 
libertarian views but 
falls short. The 
student attempts to 
explain the technical 
essentials of the 
technologies 
supporting the dark 
web and how those 
contribute to ethical 
misuses of the web, 
but most of the 
explanations are not 
correct. 

to explain the technical 
essentials of the technologies 
supporting the dark web and 
how those contribute to 
ethical misuses of the web, 
but some of the explanations 
are not correct.   

libertarian views. The 
student explains the 
technical essentials of 
the technologies 
supporting the dark web 
and how those 
contribute to ethical 
misuses of the web.   

technologies supporting the 
dark web and how those 
contribute to ethical misuses 
of the web. The student 
explains these in depth.     

 
 



 
 
 
 

 
Assignments Meeting Objective 1.3:  Computing Literacy 

Outcome #1 
Using Excel Pivot Tables 

 
KBOR Core Student Learning Outcome for Introduction to Computers and Applications:  
Outcome #1.  Effectively perform data analysis using appropriate technology such as 
spreadsheets or database applications.  
 
Meeting the Outcome:  Because pivot tables are used to query, organize, summarize, and 
graph data, they are useful for data analysis. Experienced users use pivot tables heavily, and 
Microsoft has made them much easier to use than before.  Many users are hesitant to use pivot 
tables because there is a learning curve. I have found that students like using pivot tables after 
being introduced to them because for routine work they do not have to enter formulas. They 
just need to know how to organize the data and how to place data correctly into the four 
quadrants of the dialog box. Pivot tables are a core technology for data analysis in Excel.    
 
Assignment:  Use a file with sales data to create a pivot table with a frequency distribution, 
specified summary data, and slicers (application of data filters) for selected salespersons. 

 
Criteria Not Proficient  

 
 
Score: 60 - 69 

Developing 
Proficiency 
 
Score: 70 - 79 

Proficient 
 
 
Score: 80 - 89 

Exceeding 
Proficiency 
 
Score: 90 - 
100 

Score 
/100 

Pivot Table 
Design 

The pivot 
table has 
fields placed 
apparently at 
random into 
the four 
quadrants. 

There is logic 
displayed in 
the selection 
and 
placement of 
fields in the 
quadrants, 
but there are 
some errors in 
placement. 

The correct 
elements are 
selected, and 
all the 
selected 
elements are 
in the correct 
quadrants and 
rows. 

The correct 
elements are 
selected, and 
all of the 
selected 
elements are 
in the correct 
quadrants and 
rows. The 
pivot table is 
easy to 
interpret.   

/20 

Formatting No Layout is 
applied to the 

The Report 
Layout is 

The Report 
Layout is 

The Report 
Layout is 

/20 



table or the 
incorrect 
Form is 
selected. The 
numbers are 
not formatted 
correctly. The 
report layout 
is incorrect.   

applied to the 
table with the 
correct form 
but the 
subtotals are 
not placed in 
the correct 
location. The 
numbers are 
correctly 
formatted. 
The rows are 
not banded.  

applied to the 
table with the 
correct form. 
The subtotals 
are placed in 
the correct 
location, and 
the numbers 
are correctly 
formatted, 
but the rows 
are not 
banded. 

applied to the 
table with the 
correct form. 
The subtotals 
are placed in 
the correct 
location, and 
the numbers 
are correctly 
formatted. 
The rows are 
banded. 

Proper 
selection and 
use of 
functions 

There are 
significant 
errors in 
selecting the 
functions 
(Sum, 
Average, and 
Group) or 
some 
functions do 
not appear at 
all. The Show 
Values As or 
the 
Summarize 
Values By 
operations 
are 
incorrectly 
applied.    

The Sum, 
Average, and 
Group 
functions are 
all used in the 
correct way. 
There are 
minor errors 
in applying 
the Group 
function or in 
the Totals 
calculations.   

The group 
function is 
used correctly 
to create the 
intervals. The 
Count option 
is selected to 
determine the 
frequency 
distribution. 
The Sum and 
Average 
functions are 
used 
correctly.   

The group 
function is 
used correctly 
to create the 
intervals. The 
Count option 
is selected to 
determine the 
frequency 
distribution. 
The Sum and 
Average 
functions are 
used 
correctly.  The 
labels are all 
correct.   

/20 

Proper use of 
filters (slicers) 

The Slicers 
are missing or 
they use the 
wrong fields. 
The Quarter 
field is not in 
the Columns 
quadrant. The 
Sales Person 
field and Type 
field are not 
in Rows. The 

The Amount is 
properly 
placed in the 
Values 
quadrant but 
one of the 
fields is not 
correctly 
placed in the 
Rows or 
Columns. The 

All of the 
fields are 
correctly 
placed into 
the correct 
quadrants but 
the 
hierarchical 
order is 
incorrect. The 
Tabular Form 
is used.  

Slicers use the 
correct fields.  
The correct 
fields are all 
inserted 
correctly into 
the Rows, 
Columns, and 
Values 
Quadrants to 
display target 
data. The 

/20 



Amount is not 
in Values. The 
Tabular Form 
is not used.    

Tabular Form 
is used.   

Tabular Form 
is used for the 
table format. 
The 
hierarchical 
order is 
correct.   

Proper 
placement of 
Amount fields 

The Amount 
Fields are only 
placed into 
one quadrant. 

The Amount 
Fields are 
placed 
properly into 
two 
quadrants. 

The Amount 
Fields are 
placed 
properly into 
two 
quadrants. 

The Amount 
Fields are 
placed 
properly into 
two 
quadrants.  

/20 

Total     /100 
 
 
  



The assignment and results are shown below.   
 
First assignment. Go to the Resource tab and find the data called Your first pivot table.xlsx. 
Create the pivot table below. Change the headings to Sum of Cost and % of Total (as shown), 
and add the percent column. Be sure to format the Cost numbers so that they have dollar signs 
and commas. Include Type and bike in the rows. Save the file with your name and first pivot 
table and upload it to the Assignments tab. 
 
 
 

 

 

Slicer Project. Create the table below with the Sales Person slicers. Hint: Place the Quarter field 
in the Columns quadrant. Place Sales Person and Type in Rows and Units Sold in Values. Use the 
Design tab to find the Report Layout options. Then select the Tabular Form for the table format. 
Use the Analyze tab to insert the slicer. Save the file as Your Name Slicers and Frequency Table.  

 



 
 
Frequency Distribution Project. Using the Bike transactions for pivot tables.xlsx file create a 
frequency distribution for sales. Make it look like this.  
 
 

 
Hint: drag the Amount field into Rows and Values. Then use the Group function on one column 
and the Count option in the other column. Save your file as Your Name Slicers and Frequency 
Table. 
  
 

Outcome #2 
 

Formatting a Research Document with Microsoft Word 
 
General Education CORE Outcome #2:  Effectively format documents such as reports, essays, or 
resumes using appropriate technology. 

 
KBOR Core Student Learning Outcome for Introduction to Computers and Applications:  Use word 
processing software to create, edit, and produce professional documents.   
 
Meeting the Outcome:  Students will use the tools in Microsoft Word to create a properly formatted 
research paper using the MLA style.  
 
Assignment:  Format and document a Research Paper using the MLA style.  See full instructions below 
the table.   
 
 
 



 
Criteria Not Proficient 

 
 
Score 60 - 69 

Developing 
Proficiency  
 
Score:  70 - 79 

Proficient 
 
 
Score:  80 - 89 

Exceeding 
Proficiency 
 
Score: 90 -100 

Score 
/100 

Correct use of 
MLA Style  

The title page 
(5 pts), 
footnotes (5 
pts), 
bibliography (5 
pts), citations (5 
pts), figures (4 
pts), body of 
document (5 
pts), and table 
of contents (5 
pts) elements 
are formatted 
correctly in 
MLA style.  

The title page 
(5 pts), 
footnotes (5 
pts), 
bibliography (5 
pts), citations (5 
pts), figures (4 
pts), body of 
document (5 
pts), and table 
of contents (5 
pts) elements 
are formatted 
correctly in 
MLA style. 

The title page 
(5 pts), 
footnotes (5 
pts), 
bibliography (5 
pts), citations (5 
pts), figures (4 
pts), body of 
document (5 
pts), and table 
of contents (5 
pts) elements 
are formatted 
correctly in 
MLA style. 

All the title 
page (5 pts), 
footnotes (5 
pts), 
bibliography (5 
pts), citations (5 
pts), figures (4 
pts), body of 
document (5 
pts), and table 
of contents (5 
pts) elements 
are formatted 
correctly in 
MLA style. The 
document has a 
very 
professional 
appearance. 

/34 

Content The content in 
the title page (5 
pts), footnotes 
(5 pts), 
bibliography (5 
pts), citations (5 
pts), figures (3 
pts), body of 
the document 
and table of 
contents (5 pts) 
is complete and 
correct. 

The content in 
the title page (5 
pts), footnotes 
(5 pts), 
bibliography (5 
pts), citations (5 
pts), figures (3 
pts), body of 
the document 
and table of 
contents (5 pts) 
is complete and 
correct. 

The content in 
the title page (5 
pts), footnotes 
(5 pts), 
bibliography (5 
pts), citations (5 
pts), figures (3 
pts), body of 
the document 
and table of 
contents (5 pts) 
is complete and 
correct. 

The content in 
the title page (5 
pts), footnotes 
(5 pts), 
bibliography (5 
pts), citations (5 
pts), figures (3 
pts), body of 
the document 
and table of 
contents (5 pts) 
is complete and 
correct. 

/33 

Skill in using 
word 
processing 
Software 

In many cases 
improper 
techniques 
were used such 
as incorrect file 
format (3 pts), 
inserting spaces 
instead of tabs 
(5 pts), 
incorrect 
headers or 
footers (5 pts), 

Proper 
techniques 
were used such 
as correct file 
format (3 pts), 
inserting tabs 
instead of 
spaces (5 pts), 
correct headers 
or footers (5 
pts), proper 
spacing 

Proper 
techniques 
were used such 
as correct file 
format (3 pts), 
inserting tabs 
instead of 
spaces (5 pts), 
correct headers 
or footers (5 
pts), proper 
spacing 

Proper 
techniques 
were used such 
as correct file 
format (3 pts), 
inserting tabs 
instead of 
spaces (5 pts), 
correct headers 
or footers (5 
pts), proper 
spacing 

/33 



improper 
spacing 
between words 
and sentences 
(5 pts), margins 
set improperly 
(5 pts), Word 
styles not used 
or used 
improperly (5 
pts), spell 
checker and 
grammar 
checker not 
used (5 pts), 
incorrect file 
metadata, 
incorrect 
software 
version, and 
other issues. 

between words 
and sentences 
(5 pts), margins 
set properly (5 
pts), Word 
styles properly 
used (5 pts), 
spell checker 
and grammar 
checker used (5 
pts), correct file 
metadata, 
correct 
software 
version used.  

between words 
and sentences 
(5 pts), margins 
set properly (5 
pts), Word 
styles properly 
used (5 pts), 
spell checker 
and grammar 
checker used (5 
pts), correct file 
metadata, 
correct 
software 
version used.  

between words 
and sentences 
(5 pts), margins 
set properly (5 
pts), Word 
styles properly 
used (5 pts), 
spell checker 
and grammar 
checker used (5 
pts), correct file 
metadata, 
correct 
software 
version used.  

Total     /100 
 
Assignment Instructions 
Assignment 

1. Find the research paper labelled Friendship Research Paper in the Assignment tab and open it 
up in Word. 

2. Select the whole contents of the paper by using the ctrl-a shortcut. 
3. Change the font size to 12 point, and font to Arial. 
4. Go the Layout tab and select the Margins option in the Page Setup group. 

 
After clicking on Margins select the Normal 1” all around. 

Go to the Home tab, Paragraph Group, and the paragraph dialog box. Apply the first line indent to 
the paragraphs in the body of the text and double space to the text and set as Default. 

  
Add the following information to the appropriate line starting at the top of the first page. 

 
First Line:  David Schmidt 
Second Line:  Professor Jack Bricke 
Third Line:  Philosophy 700 
Fourth Line:  March 16, 2018 
 

Use the title style for the Title and center the title, Friendship. Change the font size to 12. 
Find the Text for Research Assignment document in your Student Resources area. Then cut and paste 
the four footnotes in the designated places in the Friendship Research Paper for Student Use. I have 
indicated where to insert the footnotes in red. To insert a footnote go to the References tab and click on 
the Insert Footnote icon. 
 



In the MLA style, the footnotes should be single spaced with a space between footnotes. Further, indent 
the first line. The font should be the same as the body of the text. With that in mind, format the 
footnote accordingly. Set it as the default by selecting that option. 
 

Insert the remaining footnotes into the text and check the formatting of those footnotes. If you make a 
mistake and wish to delete a footnote, go to the superscript in the text and delete it there. If you go to 
the text in the footnote itself and delete it the line above the text will remain as well as the superscript 
in the body of the text. Deleting the superscript in the body of the text deletes all of the associated 
elements of the footnote. 
 
Continuing with the same document go to the Text for Research Assignment for Student Use file to find 
the information needed for the citations. Find the location for citation number one. Then, you need to 
indicate to Word which style you will use for the citations. In the References tab, Citations & 
Bibliography group, look for the drop-down menu for Style. That lets Word know what kind of 
formatting to apply to the citation. After you put your cursor on the location for citation number 1 click 
on Insert Citation and select Add New Source. After you have added a number of Sources they will 
appear in a list whenever you click on Insert Citation. After you click on Insert Citation a Create Source 
dialog box will appear prompting you to add information about your citation. Pick book as the type of 
source. The type of information requested in the dialog box will change depending on the type of source 
picked. For example, the information required for web pages is quite different from the type of 
information required for books. Word keeps the sources entered as data so that they for use in future 
documents (see below). 
 

 

Select Book for the 
 



Fill in the information included in citation number 1. The author is R. G. Bury, the title is The 
Symposium of Plato, the year 1909, the city Cambridge, and the Publisher W. Heffer and Sons. 
The medium is paper. After you click OK the citation is inserted. Find where to insert the other 
citations and insert them into the document. 
 
Find the four citations you have entered in the text and modify the citations by adding the page 
numbers (if I list page numbers for those citations). 
 
Create a Works Cited page at the end of the paper. First, go to the end of the paper. Then press 
Ctrl + Enter to create a page break and a new page for the Works Cited page. Place the insertion 
point on the new blank page to make it active. Then find the Bibliography button in the 
Citations & Bibliography group in the References tab. Click the button. Then click insert 
Bibliography. 
 
Notice that there are several options listed: Works Cited (the MLA option), References (the APA 
option), and Bibliography (the Turabian and Chicago style). Because we are using the MLA style 
throughout the paper, pick the Works Cited style for your references. 
 
If you have created a Bibliography and then think of another citation to add to the list of 
available sources, create the new source in the paper. Add it to the list of sources. Then go back 
to the Works Cited page. Word will display a message at the top of the list of sources giving you 
the option to update the list. Click the update option and Word will add the source to the list. 
Add a title page. 
 
Put the title of the document at the top of the page and center it. Then add your name on a 
new line and center that. Finally include the name of your school on a new line and center that. 
You can change the font to Calibri or Times New Roman, but keep the font size at 12 points. 
Then select the text and center it vertically on the page. To center it vertically select the text, 
click the Layout tab, and then click the Dialog Box Launcher in the Page Setup Group. You 
should see the following. 



 
 

Click OK. Then add the section break. To do that go to the Layout tab, Page Setup Group, and Breaks 
option. Under the Sections Breaks area pick Next Page. 

Add a Table of Contents 
 
You will place the Table of Contents on the blank page that the new Page Break created. The research 
document has headings scattered throughout the document. The Table of Contents places these 
headings in order and adds page numbers so that readers can refer to the Table of Contents and go 
directly to a desired destination. 
 
Notice that I have a variety of headings set apart from the body of the text. These headings are in 11-
point Calibri. The first one is Introduction and the second one is Pre-Condition. Find each heading. Select 
it and then click Heading 1 in the Styles Group of the Home tab. Leave the heading formatted the way 
that Word reformats it for now. Find every heading, select it, and then click Heading 1. That converts 
normal text into headings, headings that Word will recognize when it creates the Table of Contents. Go 
back to the first heading and reformat it to the required Arial 12 point MLA style text. 
 
Bold the text. Then by selecting the newly formatted text, double-click the format painter. Then use the 
format painter to change all of the headings throughout the document. 
 
Go to the blank page after the Title Page. Click the References tab, locate the Table of Contents Group, 
and click Table of Contents. You will see the options listed below. 



 
 
Pick the format of Automatic Table 2. That will insert the Table of Contents into your document. By 
creating headings using the official headings options you can save a lot of time. In this way, Word does 
the hard work for you. By planning ahead and using Heading 1, Heading 2, and so on, you can have 
Word create a nicely formatted Table of Contents automatically. 
 
Add Captions 
 
After selecting an object and clicking Insert Caption the following dialog box appears. I have filled out 
some of the information. 
 

Notice that Word gives the user the option to position the caption below or above the object as well as a 
variety of numbering options. 
 
Find the symbolic image of friendship in the research paper. Select it and enter the information above. 
Click OK. That should insert the caption below the image. 
 
Add a hyperlink. 



4) Benjamin Jowett, Phaedrus, Internet: www.fullbooks.com/Phaedrus1.html, Viewed on 
January 25, 2018. Title of Internet Page: Phaedrus. 

 
Go back into the research document and create a hyperlink for this reference. On page six in a footnote, 
the word Phaedrus appears. Make it into a hyperlink with the URL listed above. To create the hyperlink 
select the text Phaedrus, then go to the Insert tab, Links group, Hyperlink icon. Click the Hyperlink icon. 
You will see the dialog box below. Make sure that you select the Existing File or Web Page option. Then 
insert the URL into the Address location. When you are done, click OK to create the hyperlink. 
 
Screenshots from the Master File Used for Grading   
Screenshot of the Title Page

 
 
 
 
 
 
 
 
 
Screenshot of the Table of Contents 
 

http://www.fullbooks.com/Phaedrus1.html


 
 
Screenshot from the first page 

 
 



Screenshot of a formatted footnote 

 
Screenshot of an image with caption 
 

 
 
Screenshot of footnote with a citation 



 
Screenshot of the APA Bibliography (Works Cited) 
 

 
 

 
 
 
 
 
 
 
 
 

Outcome #3: 



 
 

Advanced PowerPoint Features 
 
General Education Objective 1.3 Outcome #3: Computer Literacy Requirement:  Design effective 
presentations using appropriate technology. 
 
KBOR Core Student Learning Outcome for Introduction to Computers and Applications:  Use 
presentation software to create, edit, and produce professional documents.  
 
Meeting the Outcome: Microsoft PowerPoint is the standard used for presentations in many 
environments. However, to avoid “Death by PowerPoint” PowerPoint must be used correctly, and 
presentations can be greatly enhanced by including materials produced by other applications. Slides 
need to be well-designed with deliberate focus. The slides should be readable from a distance. Font size, 
images, charts, animations, and other effects can keep the audience’s attention and focus. Slides with 
content produced by other applications can also drive the presentation.  I include a sample of materials 
produced by other applications below in the screenshots.   
 
Meeting the Outcome: Microsoft PowerPoint is the standard used for presentations in many 
environments. However, to avoid “Death by PowerPoint” PowerPoint must be used correctly, 
and presentations can be greatly enhanced by including materials produced by other 
applications. So, I require a number of materials produced by using other software.   
 
Assignment:  Use Microsoft PowerPoint to demonstrate a procedure or to present content of 
your choosing. The slides should include the following:  an image (with Creative Commons 
license), a mind map created by mind map software, an organizational chart created by a web 
application, a numerical chart (created from Excel or within PowerPoint), at least one 
animation, at least one example of Smart Art, and recorded narration for each slide. The 
PowerPoint presentations should use good design principles as outlined by David Phillips.   
 
 

Criteria Not Proficient  
 
Score: 60 - 69 

Developing 
Proficiency  
Score: 70 - 79 

Proficient  
 
Score: 80 - 89 

Exceeding 
Proficiency  
Score:  90 - 
100 

Score 
/100 

Completeness Everything 
should be 
included: 
image with 
Creative 
Commons 
License, 
 
 mind map,  
 

Everything 
should be 
included: 
image with 
Creative 
Commons 
License, 
 
 mind map,  
 

Everything 
should be 
included: 
image with 
Creative 
Commons 
License, 
 
 mind map,  
 

Everything is 
included: 
image with 
Creative 
Commons 
License, 
 
 mind map,  
 
organizational 
chart,  

 
 
5/100 
 
 
 
 
5/100 
 
5/100 
 



organizational 
chart,  
 
numerical 
chart,  
 
animation,  
 
SmartArt,  
 
and recorded 
narration.  
 
All items are 
well-designed 
and complete.  

organizational 
chart,  
 
numerical 
chart,  
 
animation,  
 
SmartArt,  
 
and recorded 
narration.  
 
All items are 
well-designed 
and complete.  

organizational 
chart,  
 
numerical 
chart,  
 
animation,  
 
SmartArt,  
 
and recorded 
narration.  
 
All items are 
well-designed 
and complete.  

 
 
numerical 
chart,  
 
animation,  
 
SmartArt,  
 
and recorded 
narration.  
 
All items are 
well-designed 
and complete.  

 
 
5/100 
 
 
5/100 
 
5/100 
 
5/100 

Software Skill Skill in using 
the software is 
not evident in 
the creation of 
the 
animations, 
SmartArt, 
voice 
recording, 
mind maps, 
charts, use of 
the image, etc. 
There are 
significant 
problems with 
3 or more of 
these 
creations.   

Skill in using 
the software is 
evident in the 
creation of the 
animations, 
SmartArt, 
voice 
recording, 
mind maps, 
charts, etc. 
However, a 
number of 
them have 
some minor 
flaws.   

Skill in using 
the software is 
evident in the 
creation of the 
animations, 
SmartArt, 
voice 
recording, 
mind maps, 
charts, etc.  

Exceptional 
skill in using 
the software is 
evident in the 
creation of the 
animations, 
SmartArt, 
voice 
recording, 
mind maps, 
charts, etc.   

/20 

Quality of 
Content 

The content is 
generally of 
low quality 
(charts, voice 
recording, 
animation, 
image, 
mindmap, and 
organization 
chart).  

The quality of 
the content is 
acceptable.   

Some of the 
content is 
quite good. 
The rest is 
acceptable. 

The content is 
exceptional. 
All of the slides 
display 
exceptional 
content.   

/20 



Follows Good 
Design 
Principles 

The 
presentation 
has little 
evidence of a 
coherent 
design. Some 
elements are 
missing.  
Elements in 
the slide 
distract from 
the message. 
The verbal 
narrative does 
not show 
much 
structure.   

There is 
evidence of an 
overall design. 
The slides 
mostly 
communicate 
a central 
message.  
Most of the 
individual 
slides contain 
one message 
per slide and 
have a central 
focus. 

There is clear 
evidence of an 
overall design. 
The slides have 
focus. Images 
reinforce the 
message. The 
animation is 
appropriate 
for the 
message being 
conveyed. The 
verbal 
presentation 
also is well 
done. 

The overall 
work is 
exceptional. 
There is one 
message per 
slide. The 
focus is 
controlled by 
font size, 
animation, and 
contrast. The 
slides flow well 
from one to 
the other. The 
images 
reinforce the 
message. The 
verbal 
commentary is 
done very 
well.  

/25 

Total     /100 
 
 
 
 
I have included examples of mindmaps, charts, and organization charts.   
 
 
Mindmap Example created by using coggle.it 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Example of an Organization Chart 
 



 

 
 
Example of a donut chart.   
 

 
 
 
 
 
 
 
 
 
 
 
Example of a flowchart. 

6.5, 26%

9.1, 36%

5.5, 22%

4.1, 16%

Rainfall in Wichita

Jan - March

April - June

July - Sept

Oct - Dec



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Example of SmartArt. 
 



 

 
 
 
 
 

Outcome #4: 
 

Collaboration Using Microsoft Word 
 
General Education Objective 1.3: Computer Literacy Requirement:  Successfully perform a 
task with others using collaborative technology.  
 
Meeting the Outcome:  Microsoft Word now has very good collaborative features.  When 
Track Changes is turned on, users can see changes others have made and comments that others 
are suggesting. This can be done in real time or asynchronously.  By sharing files that have been 
saved to OneDrive users can see changes being made to documents in real time and who is 
making the changes. After changes are made and comments or other changes suggested, the 
original author can decide to accept or to reject the changes. Finally, the author can clean up 
the document to remove the comments and to preserve privacy by cleaning up the file’s 
metadata. The students submit one document with all of the commentary and the suggested 
changes, and then they submit a second document that incorporates the changes and removes 
the commentary and cleans up the metadata. Good collaboration requires editing skills. To 
demonstrate that students know how to use good editing practices, they download a document 
that requires them to do a variety of editing tasks.      
  
Assignment Part 1:  Reflect on the various aspects of social media. From the perspective of 
being responsible digital citizen who wishes to engage in positive, safe, legal and ethical 
behavior in using social media, write a brief opinion piece on the effects of social media. Think 
about how social media (Twitter, Facebook, WhatsApp, Instagram, WeChat, and others) has 



been used and misused. Comment on how it has influenced elections and public opinion. Briefly 
comment on how it has affected social and political movements around the world. Give several 
examples. Share your document with at least one other person (give them edit privileges) and 
ask them to comment on your document with at least three comments and to make changes to 
your wording. Turn on Track Changes and upload the document with commentary. Then accept 
or reject the suggested changes, remove the comments, and clean up the metadata to protect 
privacy and upload the finished document.   
 
Assignment Part 2:  Download the document to edit and follow the editing instructions.  Since 
editing requires using good grammar, make grammar corrections when prompted. Also, show 
that you can so the following tasks:  use the replace function in Word to change words 
throughout the document (or make corrections), use the bookmark function in Word to assist 
others in editing, use the synonym capability to change wording, and use specialty symbols 
when needed.   
 
Part 1 

Criteria Not Proficient  
 
 
Score:  30 - 
34.5 

Developing 
Proficiency  
 
Score:  35 – 
39.5 

Proficient  
  
 
Score: 40-
44.5 

Exceeding Proficiency  
 
 
Score:  45-50 

Score 
/50 

Mechanics of 
Sharing 
Documents 

The 
document has 
been saved to 
OneDrive and 
shared with 
edit 
privileges.  
 
 
Track Changes 
has been 
turned on.  
 
 
One or more 
commentator
s have made 
comments in 
the document 
and/or 
changed 
wording in 
the 
document.  

The 
document has 
been saved to 
OneDrive and 
shared with 
edit 
privileges.  
 
 
Track Changes 
has been 
turned on.  
 
 
One or more 
commentator
s have made 
comments in 
the document 
and/or 
changed 
wording in 
the 
document.  

The 
document 
has been 
saved to 
OneDrive 
and shared 
with edit 
privileges.  
 
Track 
Changes 
has been 
turned on.  
 
One or 
more 
commenta
tors have 
made 
comments 
in the 
document 
and/or 
changed 

The document has been saved to 
OneDrive and shared with edit 
privileges.  
 
Track Changes has been turned 
on.  
 
One or more commentators 
have made comments in the 
document and/or changed 
wording in the document.  
 
The document with all of the 
commentary has been uploaded.  
 
There is evidence that the 
document has been cleaned up 
using Microsoft’s Inspect 
Document function or the Mac’s 
Privacy function. The metadata 
no longer discloses private 
information.   

5/50 
 
 
 
5/50 
 
10/50 
 
 
 
 
5/50 
 
 
5/50 



 
 
 
 
 
The 
document 
with all of the 
commentary 
has been 
uploaded.  
 
 
 
There is 
evidence that 
the document 
has been 
cleaned up 
using 
Microsoft’s 
Inspect 
Document 
function or 
the Mac’s 
Privacy 
function. The 
metadata no 
longer 
discloses 
private 
information.   

 
 
 
 
 
The 
document 
with all of the 
commentary 
has been 
uploaded.  
 
 
 
There is 
evidence that 
the document 
has been 
cleaned up 
using 
Microsoft’s 
Inspect 
Document 
function or 
the Mac’s 
Privacy 
function. The 
metadata no 
longer 
discloses 
private 
information.   

wording in 
the 
document.  
 
The 
document 
with all of 
the 
commenta
ry has 
been 
uploaded.  
 
There is 
evidence 
that the 
document 
has been 
cleaned up 
using 
Microsoft’
s Inspect 
Document 
function or 
the Mac’s 
Privacy 
function. 
The 
metadata 
no longer 
discloses 
private 
informatio
n.   

Reflections on 
Social Media 

There is clear 
evidence of 
reflection on 
the uses and 
misuses of 
social media. 
There are 
very pertinent 
examples of 
how it has 
influenced 

There is clear 
evidence of 
reflection on 
the uses and 
misuses of 
social media. 
There are 
very pertinent 
examples of 
how it has 
influenced 

There is 
clear 
evidence 
of 
reflection 
on the 
uses and 
misuses of 
social 
media. 
There are 

There is clear evidence of 
reflection on the uses and 
misuses of social media. There 
are very pertinent examples of 
how it has influenced elections 
and affected social movements. 
The evidence cited is relatively 
strong. The writing style is quite 
professional. 
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elections and 
affected 
social 
movements. 
The evidence 
cited is 
relatively 
strong. The 
writing style is 
quite 
professional. 

elections and 
affected 
social 
movements. 
The evidence 
cited is 
relatively 
strong. The 
writing style is 
quite 
professional. 

very 
pertinent 
examples 
of how it 
has 
influenced 
elections 
and 
affected 
social 
movement
s. The 
evidence 
cited is 
relatively 
strong. 
The 
writing 
style is 
quite 
profession
al. 

Total Points 
 

    /50 

 
Part 2 

Criteria Not Proficient 
 
Score: 30 – 
34.5 

Developing 
Proficiency 
Score:  35 – 
39.5 

Proficient 
 
Score:  40 
– 44.5  

Exceeding Proficiency 
 
Score: 45 - 50 

Score 
/50 

Using Symbols The three 
symbols are 
not inserted.  

Fewer than 
three symbols 
are correctly 
inserted.   

The three 
symbols 
are 
correctly 
inserted. 

Using the Document for 
Students to Edit the student 
has inserted the copyright, 
trademark, and arrow 
symbols. 

10/50 

Synonyms No synonym 
is inserted or 
an incorrect 
synonym is 
inserted. 

The student 
has inserted a 
synonym for 
epitome. 

The 
student 
has 
inserted a 
synonym 
for 
epitome. 

The student has inserted a 
synonym for epitome. 

10/50 

Grammar The grammar 
problem was 
not corrected. 

An attempt 
was made to 
correct the 

The 
grammar 
problem 

The grammar problem was 
corrected. 

10/50 



grammar 
issue, but it is 
not correct. 

was 
corrected. 

Misspelled 
Words 

The 
misspelled 
word was not 
corrected.  

The 
misspelled 
word was 
corrected. 

The 
misspelled 
word was 
corrected. 

The misspelled word was 
corrected. 

5/50 

Rewriting 
Sentences 

The 
suggestion 
was ignored.    

The Word 
suggestion 
was accepted.   

The Word 
suggestion 
was 
accepted.   

The Word suggestion was 
accepted.   

5/50 

Bookmark The 
bookmark 
was not 
created.  
 

The 
bookmark 
was created.   

The 
bookmark 
was 
created.   

The bookmark was created.   5/50 

Replace 
Function 

The replace 
function was 
not used 
correctly.   

 The replace 
function was 
used to make 
changes to 
the indicated 
word. 

The 
replace 
function 
was used 
to make 
changes to 
the 
indicated 
word. 

The replace function was used 
to make changes to the 
indicated word. 

5/50 

Total Points 
 

    /50 

 
 
  



This is an example of a document showing that there is collaboration.   
 
 
 

 
 
 
 
 

 
 
 
 

 
 



 

 
 
 

 
 
 
  



 
 

Objective #5: 
The Web, the Deep Web, and the Dark Web 

 
General Education Objective 1.3: Computer Literacy Requirement Objective #5: Identify the ethical 
and legal standards of conduct regarding the use of data and technology.  
 
Meeting the Outcome:  Students typically do not understand copyright issues. By documenting uses of 
creative works using the multiple Creative Commons licenses (and explaining the uses of those licenses), 
students gain an appreciation for the proper uses of creative materials. Students (and others) typically 
do not understand the extent of the misuse of private information. Companies find many ways to entice 
us to give up our privacy. Some of these ways are questionable ethically. Companies also sell 
information that we may believe is private or use it in other questionable ways. There are a variety of 
ways to keep information private. Some are careful to use encryption. One more radical way to keep 
things private is to use the TOR browser. Students learn some of the basics of how to identify the ethical 
and legal uses of private information by studying the differences of the “deep web” and the “dark web.” 
Understanding the effects of a too-extreme libertarian philosophy on the uses of the web also helps 
illuminate these issues. 
 
Assignment:  Students are asked to document and explain three ways in which companies entice us to 
give up private information. They are asked to reflect on how companies use and misuse that 
information. To gain a deeper understanding of copyright issues, students are required to explain four 
Creative Commons licenses, and to document the Creative Commons license of an image they include in 
their document. To illustrate ethical and legal issues on the web students to explain the differences 
between the surface web, the deep web, and the dark web. In explaining these differences students are 
expected to comment on the role of the Tor browser and cybercurrency. They are asked to reflect on 
the role of radical libertarian values and the creation of the dark web. They are required to read an 
article entitled “The Untold Story of Silk Road” that explains these concepts and highlights ethical and 
legal privacy issues.  
  
 

Criteria Not Proficient  
 
Score:  60 - 69 

Developing 
Proficiency 
Score:  70 - 79 

Proficient  
 
Score:  80 - 89  

Exceeding 
Proficiency 
Score:  90 - 100 

Score 
/100 

Copyright and 
Creative 
Commons 

The online 
image does not 
have a Creative 
Commons 
license, and/or 
and the license 
is not explained 
properly 
The following 
licenses are not 
explained in 
some detail: 

The online 
image has a 
Creative 
Commons 
license, and the 
license is 
explained. 
  
The following 
licenses are 
explained in 
some detail: 

The online 
image has a 
Creative 
Commons 
license, and the 
license is 
explained very 
well. 
The following 
licenses are 
explained in 
some detail: 

The online image 
has a Creative 
Commons license, 
and the license is 
explained very 
well. 
   
 
The following 
licenses are 
explained in some 
detail: 

15/100 
 
 
 
 
 
 
 
 
 
 
 
5/100 



-Attribution (CC 
BY) 
-Attribution 
ShareAlike 
(CCBY-SA) 
-Attribution-
NoDerivs (CC 
BY-ND) 
-Attribution-
NonCommercial 
(CC BY-NC) 

-Attribution (CC 
BY) 
-Attribution 
ShareAlike 
(CCBY-SA) 
-Attribution-
NoDerivs (CC 
BY-ND) 
-Attribution-
NonCommercial 
(CC BY-NC) 

-Attribution (CC 
BY) 
-Attribution 
ShareAlike 
(CCBY-SA) 
-Attribution-
NoDerivs (CC 
BY-ND) 
-Attribution-
NonCommercial 
(CC BY-NC) 

-Attribution (CC 
BY) 
-Attribution 
ShareAlike (CCBY-
SA) 
-Attribution-
NoDerivs (CC BY-
ND) 
-Attribution-
NonCommercial 
(CC BY-NC) 

 
 
5/100 
 
 
5/100 
 
 
5/100 

Differences in 
the Surface 
Web, the Deep 
Web and the 
Dark Web 

The Surface 
Web is not 
explained with 
any depth.  
 
 
 
The Deep Web 
is not explained 
with any depth. 
 
 
 
The Dark Web is 
not explained at 
all or with any 
depth.       

The Surface 
Web is 
explained in 
elementary 
terms.  
 
 
The Deep Web 
is explained but 
superficially. 
 
 
 
The Dark Web is 
explained but 
not with much 
depth.       

The Surface 
Web is 
explained with 
technical 
understanding. 
 
 
The Deep Web 
is explained 
with technical 
understanding 
 
 
The Dark Web is 
explained with 
technical 
understanding.       

The Surface Web 
is explained quite 
well.  
 
 
 
 
The Deep Web is 
explained quite 
well. 
 
 
 
The Dark Web is 
explained with 
great insight.     

5/100 
 
 
 
 
 
 
5/100 
 
 
 
 
 
 
5/100 

Radical 
Libertarian 
Beliefs about 
the Web 

The answer 
shows that the 
concept is not 
understood.     

The answer 
shows some 
superficial 
understanding 
of the concept. 

There is 
evidence of 
reflection on the 
nature of radical 
libertarian 
believes and the 
pitfalls 
associated with 
those beliefs. 

The student has a 
good grasp of the 
nature of radical 
libertarian beliefs 
and on how those 
believes can lead 
to crossing the 
line into illegal 
activity on the 
web.     

15/100 

Companies 
Using and 
Misusing our 
Data 

Three ways that 
companies 
entice 
customers to 
give up their 
data are not 
documented 
nor well 
explained. The 
ethical or 
unethical 

Three ways that 
companies 
entice 
customers to 
give up their 
data are 
documented 
but not 
explained well. 
The ethical or 
unethical 

Three ways that 
companies 
entice 
customers to 
give up their 
data are 
documented 
and explained. 
The ethical or 
unethical 
aspects of 

Three ways that 
companies entice 
customers to give 
up their data are 
documented and 
explained. The 
ethical or 
unethical aspects 
of collecting and 
using the data 
discussed in 

35/100 



aspects of 
collecting and 
using the data 
discussed 
superficially.  

aspects of 
collecting and 
using the data 
discussed 
superficially.  

collecting and 
using the data 
discussed in 
some depth.  

depth. The 
student clearly 
understands 
ethical issues 
related to data.  

Total Points 
 

   100 100 
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